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BioTester 5000 User Manual

1. General Information

The BioTester 5000 is a precision test instrument specifically designed for the measurement and
analysis of small biological specimens. The system includes a compact biaxial test station and an
integrated software interface to run and analyze test results. The system is intended for indoor
use only.

Environmental and Electrical Specifications

Electrical Input 100-240VAC, 50-60Hz
Current Rating 2.71 Amp
Environmental Conditions Maximum Operating Temperature 25°C

0% - 95% Relative Humidity

Installation Category Category I

Pollution Degree Degree 2

Maximum Altitude 2000m

Data Connections 1 - USB 3.0 for camera/PC communication

1 — USB for controller/PC communication

System Assembly

The BioTester 5000 unit requires some assembly. See Appendix A and C.

Power Connections

Connect power supply into properly grounded 100-240VAC power source to ensure safe
operation. Ensure that the power cord is always easily accessible. The use of an Uninterruptible
Power Supply (UPS) is recommended to protect against data loss.

The mains supply voltage fluctuations should not exceed 10% of the nominal supply voltage.

Safety Warnings

This equipment must be used in accordance with the procedures outlined in this manual to
prevent injury and/or damage.

System Alert
The plastic covers must remain on this unit at all times to prevent injury and/or damage.

This equipment must not be disassembled by the user or modified in any way.

Approvals and Certification
This product conforms to EN61010-1 and EN61326-1.



BioTester 5000 User Manual

Manual Operating Controls

There are a few manual controls on the unit. The camera housing contains two adjustment knobs
that are used for fine adjustment of the horizontal camera position, and the camera lens has
focus, zoom, and iris rings which can be set by the user.

BioTester 5000 Tip: Setting Camera Controls

The camera housing knobs are used to ensure that the specimen is centered in the field
of view. The iris is usually left 100% open; the brightness of the images is better
adjusted by changing the camera gain and exposure in the software settings.

There are two switches on the front of the unit, one for powering the controller and the LED
lighting, and the second for powering the heating element.

The front of the unit also contains a pull rod which is used to raise and lower the specimen stage
and fluid chamber. This rod is spring-loaded so that the chamber can be held at any height. To
raise or lower the stage, lift the rod and then pull or push.

Software

LabJoy software is included and is required to run the BioTester 5000. 2 x USB ports are
required for data connections, with at least one of those ports being USB 3.0. Windows 10 or
higher is required to run LabJoy.

General Maintenance

Clean the system as needed with mild soap and water or alcohol-based cleaning solutions.

BioTester 5000 Tip: Removing the fluid chamber

The fluid chamber can be removed by resetting (fully retracting) the actuators followed
by carefully lifting and twisting the chamber. This is best accomplished when the
chamber is emptied (The large syringe supplied works well to drain the fluid bath).
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2. Testing Terminology

The BioTester 5000 is designed to apply biaxial forces to soft tissue specimens (deforms by more
than 1% in vivo) with an in-plane dimension of 3 - 15 mm. This includes biological material such
as eye tissue, heart valves, pericardium, joint capsules, large blood vessels, scaffolds, and soft
polymers.

Multiphase Test Cycles

In order to properly characterize and test a specimen, it is often necessary to load it to different
degrees and at different rates. There are three main reasons for doing this:

Preconditioning - The goal of preconditioning is to restore a specimen to its physiological or
in vivo state. During the process of specimen storage and preparation, a specimen may
swell, dry out, have its material fibers realign, or its molecules reorganize. It may take multiple
preconditioning cycles for a specimen to be restored to its natural state.

Reproducing Physiological Conditions During Testing - By applying various loads and
load rates, natural expansion and contraction of a specimen can be reproduced (for example,
the pulse pressure in an organ). In as much as the physiological conditions can be recreated,
the specimen can be tested in a more realistic state.

Varying Test Conditions - Variable loads and rates allow you to create a variety of test
profiles to best study your specimen.
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Phases, Cycles, and Test Sequences

As the following diagram demonstrates, each application and release of load on the specimen is
called a test cycle. The same test cycle can be repeated multiple times to achieve a certain goal
(preconditioning, physiological conditioning, or testing); this is called a test set. Finally, a test

sequence is made up of multiple test sets.

Displacement
‘Or Force

T T T
Time
Preload Stretch Hold Recover Rest
Phase Phase Phase Phase Phase
o AL J
~" ~
Cycle1 Cycle2
S— Al /
— ~
Set1 (Preconditioning) Set2 (Testing)
__—/

Test Sequence

The above example describes the following:
« The entire diagram presents a full test sequence.

Within that sequence, there are two test sets: the first set applies preconditioning to the
specimen; the second set executes the actual test on the specimen.

Within the first set (preconditioning), two identical test cycles are implemented to bring
the sample to a satisfactory in vivo state.

« Finally, the second set (testing) is made up of three cycles.
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Test Phases: The Smallest Unit of Testing

The test phase is the smallest unit of the test specification. There are five phases within a cycle.
Each phase serves a specific purpose:

Preloading- Preloads are applied to bring a test Displacement
to a well-defined starting point. Because the A
dimensions of a specimen may change as a
result of a loading cycle (stretching of fibers,
viscoelastic effects, plastic deformation, or
localized material failure at the attachment
points), the preload adjustment compensates for /
|

any of these changes in specimen geometry. ‘ l

Stretching - During the stretch phase, a : :
deformation is applied to the specimen. The

deformation can be specified either in terms of Biciosi: Shctali Mold Heteuss Rest
force applied or displacement achieved. Phase Phase Phase Phase Phase

Holding - The deformation can be held for a given duration. The duration for which it is
held is dependent on the nature of the testing.

Recovering - The recovery phase is the time during which the force being applied to
the specimen is removed. The duration of the recovery time is configurable and
dependent on the nature of the testing.

Resting - Finally, the rest phase is the time between the end of one cycle and the
beginning of the next. Some tests may specify a short recover time, while others may
specify a longer time. The duration is configurable and dependent on the nature of the
testing.

Control Modes

There are two control modes which define the basic approach to a given test: displacement
control and force control.

Under displacement control, the displacement of the specimen is predefined. The
BioTester 5000 stretches the specimen until the predefined displacement is achieved.
The force required to achieve the displacement is an output of the test. Several control
functions are available for displacement control.

Under force control, the force applied to the specimen is predefined. The BioTester
5000 stretches the specimen until the predefined force is achieved. The displacement
required to achieve the force is an output of the test. Force control can be applied as a
ramp or sinusoid function.

In addition, strain control from image feedback is available for the BioTester 5000. This control
mode utilizes displacements based on a region within a specimen rather than global actuator
displacements. For more information on this control mode and how to set up a protocol with this
mode, see the Strain Control from Image Tracking section below.
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Control Functions
The BioTester 5000 makes it possible to test specimens under several control functions:
Under Displacement or Force control:

The ramp function applies the displacement or force at a constant nominal rate. This is
equivalent to a constant engineering strain or constant velocity.

The sine function applies the displacement or force according to a sinusoid with the
desired displacement magnitude and duration.

The control mode, load function and load magnitude can be set independently for each of the two
loading directions.
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3. System Overview

System Components

The BioTester 5000 brings together several high-precision components, making it the state-of-
the-art instrument for testing biomaterials.

High-resolution CCD camera
A provides synchronized video
tracking and analysis.

lllumination and lens
B provided to capture excellent
image quality

Our patented BioRake
attachment method provides
quick and easy mounting of

samples.

Integrated machine controls
and data collection are
compact and designed for
testing flexibility.

High resolution control
delivers precision
measurement on small
samples.

A simple USB interface for
F easy connection to the host
computer.
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Software Overview

The software included with the BioTester 5000 is called LabJoy. It is divided into two modules, a

data collection module and a review and analysis module. The data collection module is used to

set test parameters, enable specimen loading and testing, and monitor test progress. The screen
layout for this module is shown below:

Test
Parameters

“Y4¥EbELINS
==

Live Force &
Displacement

Live Video Live Charting

The Data Analysis software is an additional program used to review and analyze data and images
collected by the BioTester 5000. For more details, see the included Data Analysis user manual in
the Documentation folder (Cellscale>Labjoy>Documentation).

5 SampieTestist - Datainalysic

fie tielp Toots
sampietestist [

‘Dot (image

o X Avis [ Tume (S) v YA | YDisplacement (um) v

VDisplacement (um) vs. Time ()

EL AR

Yorsplacement wm)

T 2 3 4 85 6 T 8 8 1 1 12 1 1 15 % 7 W W % 2 2 N M3 % 5 2 5 0 5 2 B M % % ¥ B %N & & & & & & 6 & &
Teme (5)

om 1] 08

Currert Point Chatt Fters Curve Fits

v o Ve = C—— = Coneres o ¥ ows]
T [osao O] la u« ) —— |

XDisplacement (um) | 25100

XForce (mN) .ZAEL\)

XSize (um) 7'"15‘57

VDuplacement (um) 2235.00

YForce (mM) .Elxi 10

YSize () .IIZ‘)DO

23 Fom Delete Selected A Carve P Deete Curve .
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Output Files and Data Structures

For each test, the BioTester 5000 creates and saves three file types. The following table
describes the three file types for a project named “Sample1”. Output from this test would be found
in a “Sample1” output directory (a sub directory of the user specified data directory).

st file The Sample1.tst file that contains the exact protocol and settings used for the test.

.csv file The Sample1Data.csv file that contains comma separated numerical data such as time, force and
displacement values.

Jpg files Captured images such as Sample1.000010.3.jpg, which would correspond to an image captured
at 10.3 seconds from the start of the test.

Each test folder will also contain 2 subfolders. The “Logs” subfolder contains a text file of the
content of the text dialogue portion of the main screen. It is useful as a reference to troubleshoot
problems with your system, should they occur.

Additional “Analysis” and “Tracking” folders will be created if the data file and/or images are
reviewed and processed in the Data Analysis software module. These folders will store tracking
information and other preference settings. For more information, see the Data Analysis user
manual in the Documentation folder.

When working with the data, you should be aware of a few details regarding the data output:

1. The output specimen sizes are based on the spacing between the BioRake tines and do
not account for the specimen material outside of the test region.

2. The software cannot calculate stresses since the thickness of the specimen is not known.
To calculate stress, you will have to manually measure the thickness of the material
before or after the test is performed.

3. Strains can be calculated using the output displacement values (which are based on the
BioRake tine motions). The specimen may actually be subjected to less strain than the
calculated values due to attachment site effects and tissue tearing. The image tracking
module is useful for determining the actual strain values and variations within the
specimen.
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4. Setting Up & Starting a Test

Overview

Setting up and running a new test is a simple process made up of both mandatory and optional
steps. The following list presents all the steps, while the rest of this chapter describes each of the
steps in detalil.

Step 1: Start a New Test

Step 2: Reset the Actuators

Step 3: Move the Actuators to a Specified Size
Step 4: Zero the Load Cells (occasional)

Step 5: Modify the Test Parameters (optional)
Step 6: Mount the Specimen

Step 7: Execute the Test

Step 8: Terminate the Test Prematurely (optional)

Step 9: End of Test Controls (optional)

Step 1: Start a New Test

Launch the LabJoy software, and then be! Labloy

select Collect New from the File menu. In File = Help

the Create Test from Template dialogue, Collect New Ctrl+N

perform the fo”owing StepS: Analyze And Review Images Ctrl+A
Review Protocol Ctrl+R

Import Images

Exit

1. Select a template that matches the type of test you wish to perform. See the BioTester
5000 Tip on how to select and use a template. You can modify the template parameters
in Step 4, below.

2. Name your test. The dialogue will have a default test name. You can use the default or
rename the test. Each time you start a new test, the default name will continue to
increment the number at the end of the name.

10
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data and images is determined by specifying a Test Name and Data Directory. The

If desired, you can change the location of the output data. The location of your output

template and data directories are user specific (computer login name). Each system user

can store their files to a different default location. The system uses the last location
selected as the default.

Create Test From Template X
Select

Test Name

’Test_om

Data Directory
’ C:\Celiscale\Labjoy\Data Browse

Template Directory

’ C:\Cellscale\Labjoy\Templates Browse I

oK I Cancel

BioTester 5000 Tip: Selecting and Using Templates

How to select a template: Designing an appropriate test sequence is an art that
depends on both the type of material being tested and the specific material properties
you are interested in measuring. When first testing a new material, you should expect to
have to experiment with the settings until the test yields meaningful data.

The system comes loaded with example templates to help you get started. Selecting a
template does not lock you into a specific test sequence or protocol — rather a template
defines a test sequence and settings, all of which can be changed before a test is run.
Once you have developed a test sequence and settings that are appropriate for the
material you are testing, you should save these settings using “Save As Template” from
the File menu. You can then select your template the next time you initiate a test.

11
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Step 2: Reset the Actuators

We suggest performing an actuator reset at the start of a new test. Also, if you have stopped the
previous test in mid cycle, then you should reset the actuators. By resetting the actuators, you are
moving the actuators to the precise home position ensuring that the displacement measurements
taken by the BioTester 5000 are accurate.

To reset the actuators, select Reset Actuator from the tools menu, or press @ on the toolbar.

If the below warning dialogue appears, select Yes. This warning is to remind the user not to reset
the actuator with a specimen mounted.

Please ensure that you have no specimen mounted

Q Are you sure you want to Reset Actuators now?

Yes No

System Alert

The actuators SHOULD NOT be reset if the specimen is already mounted. Doing so will
damage your specimen as well as possibly damage the BioRakes or Load Cells.

Step 3: Move the Actuators to a Specified Size

After the actuators have been reset, they will remain in their fully retracted positions and must be
moved to specified (reference or starting) positions.

To move the actuators to the specified position, select Move Actuators to Specified Size from the

Tools menu, or press x on the toolbar. The desired size must be entered in the boxes labelled
Specified Size (um) X'Y.

Specified Size (um) XY

I 4700 4700

12
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Step 4: Zero the Load Cells (occasionally)

While it is not necessary to zero the load cells with every test sequence, we suggest zeroing the
load cells at the start of a new test session. With repeated use, the zero point of the load cells can
drift. By zeroing the load cells, you are ensuring that the force measurements are accurate.

e
To zero the load cells, select Zero Load Cells from the Tools menu or press e on the toolbar.

System Alert

You should not zero the load cells if the specimen is already loaded, or the load cell
zeroing process will not work properly and an offset will be introduced into your force

data.

Step 5: Modify Testing Parameters (optional)

You can select and modify parameter Set Parameter Editor X
sets by clicking on their row in the Test
Sequence table and then pressing the Name | Frecon (Example: “Precont’, "HoldA) ——
Edit Set button (or by double clicking on X A ¥ Auxis
their rOW). When you do SO, the Set Control Mode Displacement v Control Mode  |Displacement  +
Parameter Edltor dlalogue WI” appear' Control Function |Ramp b Control Function |Ramp *
N_Ote that dis_placements are SpeCiﬁed in Stretch Magnitude 10 % T Stretch Magnitude 10 % T
either % strain, or ym. Force loads are preload
. A . Preload
spec!f!ed in mN, and durations are & Not Applied & Not Applied
Sp90|f|ed n Seconds- " Applied on 1st Repetition Only " Applied on 1st Repetition Only
. . " ReApply On B Repetiti i iti
The following table describes each of PPy TR BEn epeTen Refpply On Evew Repetition
the parameters_ Preload Magnitude [mi) | 100 Preload Magnitude (mi) | 100
Cycle
Stretch Duration (5] | 20 ™ Do Mot Stretch Repetitions |3
) Data Output -
Hold Duration (5 0 Frae:ueﬁcﬁL[le] 1
Recovery Duration (5} | 20 I Do Mot Recover  Image Output m

Frequency [Hz)

Rest Duration 0 |

OK | Cancel

13
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| Description ‘
Biaxial tests are typically performed under displacement control; however, you can
select the following control modes to achieve specific testing objectives:

e To obtain uniaxial properties for a biaxially mounted specimen, specify
displacement control in one axis and Force control with zero Load Magnitude
in the other axis.

e  For creep testing, use a preload with a long hold duration.
o  Forrelaxation testing, use displacement control with a long hold duration.

Control Function

True Strain (Displacement Control only), Sinusoidal, or Ramp is typically selected for
tests performed in displacement or force control mode. True Strain tests can only be
run in displacement control mode.

Stretch Magnitude
(Load Magnitude when in
Force Control mode)

Selecting a stretch magnitude is entirely dependent on the material you are testing. A
sound approach is to begin with a small magnitude and iteratively move up to larger
magnitudes.

If you are using Displacement control mode, you can specify the displacement in either
um or as a percentage. For example, the displacement on a 5000um x 5000um
specimen can be expressed as either 500um or 10%.

If you are using Force control mode, you can only specify the force in mN.

Watch the test results carefully to determine which magnitude setting best achieves
your test goals.

Preload

Preload is typically reapplied on every repetition during a preconditioning set as well as
on the first repetition of a testing set. Specimen size is adjusted after a preload
adjustment. Strain calculations are based on the specimen size after the last preload
adjustment. If you are working with a material for which preload values have been
suggested, you can set the value accordingly. Otherwise, zero is a good initial choice.

Preload Magnitude

As with stretch magnitude, the preload magnitude settings depend on the material you
are testing. While Preload can be set at zero, typically you would set the preload
magnitude somewhere between zero and 10% of the peak load you expect to achieve.

Stretch Duration

For evenly spaced images, it is recommended to choose a number that is an integer
multiple of the Image Output Frequency.

Hold Duration

Hold Duration is typically set to 0, however it is useful for creep or relaxation testing.

Recovery Duration

Recovery Duration is typically set to the same value as the Stretch Duration.

Rest Duration

Rest duration is typically set to 0, however a non-zero value may be used to mimic in
vivo conditions or for specialized testing.

Repetitions Apply enough repetitions until the force deformation curves from one repetition to the
next start to overlie each other.
Data Output Frequency | Typically set to the same frequency as the image output frequency.

Image Output Frequency

Typically set to 1Hz for cycles > 5 seconds and 10 Hz for cycles < 5 seconds.

To capture images higher than 15Hz, the image resolution can be lowered to
accommodate that.
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Step 6: Mount the Specimen

Proper specimen mounting is critical to ensuring accurate and repeatable results. It is best to
have the tines spaced evenly across the edge of the specimen and as closely to the edges as
possible.

To mount the specimen, follow these steps:

1.

10.

Place the specimen in the mounting press on top of a backing material such as the
supplied soft silicon or a piece of foam.

Place the mounting bridge across the fluid chamber.
Partially raise the mounting bridge.

Centre the specimen between the rakes using a small
implement, such as forceps, and the live video window
as feedback. Adjustment of the actuators may be
necessary to ensure the rake tines are positioned
correctly for non-ideally sized specimens.

Raise the stage until the rake tines are pressing gently
on the specimen.

Push all 20 tines into the specimen, either all at once
using the press block or one at a time using a small
implement such as a precision screwdriver.

Partially lower the stage and remove the backing
material.

Fully lower the stage and remove the mounting bridge.

Fully raise the stage to submerge the specimen, if
desired. Typically, you will want to match a specimen’s
physiological state, which for most biological materials
is in a saline solution heated to the organism’s body
temperature.

To minimize the effect of surface debris and surface
ripples, a cut-out has been made on the top of the fluid
chamber that is sized to hold a standard microscope
slide.

BioT ester 5000 Master Ct
1

Force X (mN) |1
Force Y (mN) [5

Current Sze'Y fum)  [4700

Shutter (mS) {150

Curert Temp. (C) [230 )

Actuator Control
Jog Speed (1-10)

L
T =
s
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BioTester 5000 Tip: Ideal Specimen Size

The BioTester 5000 is designed for small specimen sizes. For Standard BioRakes (5
tines spaced at 1 mm) the ideal specimen size is square with side lengths of 5.5 - 6 mm.
If a specimen is not in the ideal range, it may still be mounted, but the placement of the
rake tips will need to be adjusted. Also, BioRakes of different size are available and may
be used.

Manual adjustment of rake positions during specimen loading may be necessary to
ensure that the rakes puncture the sample correctly.

These manual adjustments result in a change in specimen size, which in turn results in
a change in actuator displacement profiles. The specified specimen size is displayed at
the top of the screen while the current specimen size is displayed on the left of the
screen just below the force output.

At any point before the test has started, specimen size can be changed using one of the
following methods:

e Press x on the tool bar, or from the Tools menu select Move Actuators to
Specified Size

o Use the Actuator Control jog button Actuator Control P
arrows. aF

E 5

+- Axes:

+ Mirror Matching
" Independent

Step 7: Execute the Test
Select Execute from the File menu or press the button on the toolbar.

Step 8: Terminate the Test Prematurely (optional)

You can stop a test at any time by clicking 9 on the toolbar, or by selecting Stop from the File
menu. This is preferred method as opposed to powering down the equipment, as it allows the
software to store the current actuator position.

At the end of the completed test (both normally and prematurely terminated) the actuators will
maintain their current position.

BioTester 5000 Tip: Specimen Thickness

Measuring the specimen thickness before and/or after a test is performed will allow
stress calculations to be made from your output data. You can input this data in the
software under the Specimen Menu

17
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Step 9: End of Test Controls (optional)

Once the test has been completed, you can choose to start a new test or use the system controls
by selecting the “OK” button.

End of Test X

Test has been Successfully Completed.
k. ¥

Start a New Test

System controls include the top ribbon as well as Actuator Control. These controls can be useful
if you need to release a specimen from the text fixtures at the end of a test.

(OLCk & 3

Actuator Control

iy s

Jog Speed (1-10)

A
E 5
v N
4 b ‘ b +- Axes:
A (® Mirror Matching
\ 4 (O Independent
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5. Strain Control from Image Tracking

Strain control from image tracking is an alternate test control mode that can specify and control
the test displacements based on a region within a specimen rather than the global actuator
displacements. When deforming a specimen, strain values often vary near the attachment sites
compared to the middle region of a specimen. This is especially evident when using BioRakes
which tend to deform more around the rake tine puncture points compared to other parts of the
specimen. Clamped specimens usually have lower strains around the clamps because the
clamps prevent lateral deformations.

In biaxial testing, strains in the center of a specimen can be significantly less than the actuator
strains and local strains in the X and Y directions are often different from each other.

Controlling the applied strain in a region of a specimen is achieved by tracking image features in
real time during test execution.

When a template with Strain Control from Image Tracking protocols is opened, the pop-up
window shown below will appear to indicate so.

Protocol is using Strain Control from Image Tracking X

(& 1. Adjust tracking point locations by
{ | < 5 - - . .
clicking and dragging point rectangles shown on the live video.

See user manual for more information.

OK

(] Don't tell me again
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Specify Testing Parameters

Same As X

b

b

To use strain control: Set Parameter Editor
1. Double click or select Edit on the Name Precont (Example: “Precont’, “HoldA')
desired protocol line to open Set X Auis ¥ Axis
Parameter EdltOI’ Control Mode Control Mode 5train From Image
2' SeleCt Straln From Image a-s the Control Function  Sinusoid e Control Function  Sinusoid
Contro! MOd?' ThIS- ch.ie will only Magnitude 0 =% v Magnitude 0 =%
be available if a scientific camera
. Preload Preload
set up is connected. _
. ) © not Applied © Not Applied
3' SeleCt SInUSOId or Ra‘mp ContrOI () Applied on 1st Repetition Only () Applied on 15t Repetition Only
funCtlon. () ReApply On Every Repetition (O) ReApply On Every Repetition
4. Magnitude is in % and is <':a'1lculated el 100 reload Magnitude [my) 100
as the change in length divided by —
the initial length at the start of the Cycle
stretch phase. The initial length is Stretch Duration (5] 10 () Da Not Stretch Repetitions 1

r prel .
updated after preloads Hold Duration (5] 0 Haldoinuie o
! Frequency (Hz)
Recovery Duration (5} 10 () Do Not Recover Image Output
Frequency (Hz)

Rest Duration 0

System Alert: Preload with Strain from Images

When using preloads with the strain from images control mode, the force control
velocity parameter must be set to a value of 4 or lower. Higher velocity settings may
result in failure to execute the preload due to the image tracking algorithm speeds.

If the force control velocity setting is greater than 4, it will automatically be reduced to 4
upon executing the test to ensure successful completion of the preloads and test
protocol.

UniVert

Warning: Using Preloads with Strain from Image
Requires Force Control Max. Velocity
To be setto 4 or less.
[see: Motion Control from Settings menu)
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Selecting the Tracking Point Locations

A test protocol that is using strain control with image tracking will display a rectangle in the live
video feed as follows:

The small squares are the points that will be tracked. The location of the tracking points can be
adjusted by clicking and dragging the corners of the box or the center tracking points on each
side.

The average distance between all pairs of points is used for strain calculations. Tracking is
performed using a digital image cross-correlation technique with updates at 20 Hz. For strain
control using image tracking to be successful, there must be sufficient texture patterns or fiducial
markers present in the images. Texture patterns can be added to specimens with marking pens
or a light dusting of graphite or other contrasting powders on the specimen.

The colour of the tracking box and points can be adjusted in the Strain Control from Image
Tracking Settings (see below).

Configuring the Live Charting Graphs

The strains can be displayed on the live charting graphs when using the strain control from image
tracking feature. The graphs can display measured strain or nominal strain.

¢ Measured Strain is the calculated strain from the image tracking.
e Nominal Strain is calculated from the motion of the actuators.

The graph settings can be specified by selecting Graphs from the Settings menu.

Graph Settings 'Y
Graph 1
Xhuis
Time (5) vlato ~| min[0 | ma[23 |
Yaxis
Force (N) “llate ~| min[o | ma[1 |

Graph 2
Xhxis
Time () v Ao~ Min
Yaxis

Measured Strain (%) R

Graph 3
Xhuis

Time (5] vlato | wmin[o | wma[s |
Vhxis
Nominal Strain (&) vlado v| M0 | Mx[1_ |

[ Clear Graph Between Sets
[ Clear Graph Between Cycles
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Configuring Output Data Files

Measured and Nominal strains are
available as test output columns for
the csv data file. From the Settings
menu, select Data Output. Then
click the Configure button to select
the desired output columns.

BioTester 5000 User Manual

Data Qutput Column Chooser

Available Output

Repeat
Temperature [*C)
System Time

Cancel

Add -->

< Remove<

Use These Qutput
In This Order

SetMame

Cycle

Time (5]

Size [mm)
Displacement {mm]

MominalStrain (3g)
¥ MeasuredStrain 55

Move Up IMowe Down

[Or Drag Selections With Mouse)

Strain Control from Image Tracking Settings

To access the settings for Strain Control from Image Tracking, select Settings in the top ribbon
and Strain from Image. The colour of the tracking points can be modified as well as
disabling/enabling the pop-up window at the beginning of each test.

Strain Control from Image Tracking Settings

Color Tracking Points Color

[C] Do Not show startup message.

Cancel

X

OK
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Executing the Test

Upon executing a test, the dialog box shown below will appear. It gives options to automatically
adjust camera settings and to automatically adjust tracking point locations. Optimized lighting
and camera settings and adjusted tracking points locations may improve the success of tracking.

Click proceed with Test to execute the test. If the software is unable to continuously track a point,
the test will automatically stop to prevent any damage to the system. If this occurs, more textured
patterns or unique features may be required to generate better tracking points for the software to
follow.

Strain Control from Image Tracking X

1. Optional: Reduce tracking point field.

Tip: To achieve consistent tracking
by 0 % point locations across tests -
place tracking field on rake tine tips

and reduce field to desired size,

Apply Undo

2. Optimized lighting and camera settings can improve tracking success.

Optimize Camera Settings 30 Gain (0-100)

Recommended. 10 Exposure (ms)

3. Optimized tracking point locations can improve tracking success.

Optimize Tracking Points Recommended.

4, Sufficient image features are necessary for tracking success,

Feature Quality Feature quality can be improved

by marking the specimen

Good
oo | such as with graphite power

or marker pens.

Back to Setup Proceed with Test
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Advanced Controls

Strain control from image tracking
is controlled with a PID control
algorithm. The PID control
parameters can be adjusted by
selecting Motion Control from the
Settings menu in the top ribbon.

Check the Edit Advanced Settings
check box then select Strain from
Image in the control mode drop
down menu.

Increase the Kp value if the system
is not responsive enough or cannot
achieve the specified strains.

Decrease the Kp value if the
system is producing unstable or
oscillating results.

The hardware defaults should work
under most conditions and can be
restored with the Reset to
Hardware Defaults button.

BioTester 5000 User Manual

Motion Control Settings X

X Axis Y Axis

Max. Velocity (1-10)
(Force Control)

1

ii
iI

Acceleration (1-10)

Note: To Save Velocity and Acceleration settings to a Template

Select Save As Template from the File Menu.

Edit Advanced Settings
Control Mod‘ Strain From Image > Strain From Image v ,

Adaptive

@®PID ®PID

] ]
G R

Reset to Hardware Defaults

Adaptive
Algorithm

Note: Improperly tuned PID settings may result in unstable behavior.

Apply Done
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6. Additional Settings

Configuring Output Data Files

From the Settings menu,

select Data Output to display the dialogue shown on the left. Click the

Configure button to select which of the following columns to output.

Data Output Settings > Data Qutput Column Chooser *
Farmat Available Output Use These Output
In This Order
« Repeat Set Name
System Time Cycle
X Compensat_ion {um]) Time (5] .
Output Columns ¥ Compensation [um) Add s ;esr:'lzze[rua;an]lre [*C)
¥ Size [um]
Confi ¥ Displ t
S|
% ¥ Faorce (mM)
¥ Force (mM)
Images
JPEG Quality |90 [0-100)
¥ Store in a SubFolder “Images” Move Up Move Down
(Or Drag Selections With Mouse]
oK | Cancel | oK I Cancel |
Output Column | Description ‘
Set Name User defined name of each set
Cycle Cycle and Phase information
Time (S) Time in seconds
XIY Size (um) Distance between opposite pairs of BioRakes
XY Force (mN) Load Cell reading
X/Y Displacement Reports the change in size relative to the initial size
Set Name Name specified for each set
Temperature (°C) Current temperature
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Advanced Settings

Advanced settings are available by selecting Advanced from the Settings menu. All of these
settings are template specific unless otherwise noted.

Advanced Settings

Show Warnings
[+] Before Reset Actuators
Before Zero Load Cells
|:| Prompt for Valid Specimen Dimensions

System Stiffness Compensation

[|Enable Requires a Calibration [see Tools -> Advanced) 7

Advanced

|:| Enable non-standard Image Output Frequencies
|:| Enable Hardware Diagnostics

Mote: To Save these settings to a Template
Select Save As Template from the File Menu.

Show Warnings

By selecting the check boxes, a warning dialogue will appear before either action button (i.e.
Reset Actuators or Zero Load Cells).

Resetting the actuators with a sample attached may damage the specimen, BioRakes, and/or
load cells. To avoid resetting the actuators with a sample attached, a warning dialogue will
appear after “Reset Actuators” is selected, prompting the user to proceed.

System Stiffness Compensation

System Stiffness Compensation can be used to compensate for the small displacements that
occur in the system during testing due to flexion and load cell compression/tension. These
displacements arise from any strains in the load cell and any bending or deformation of the

system during loading. Under most loading conditions of the BioTester5000, these displacements
are negligible and system stiffness compensation is not required. It is recommended to leave the

System Stiffness Compensation as Enable>Auto.
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Advanced

Checking the “Enable non-standard Image Output Frequencies” will enable Image Output
Frequencies options between 1 and 20 in the Parameter Editor. It is important to note, the
scientific camera will not be running at those frame rates natively. The camera will operate at its
highest frame rate (45 fps) and the nearest frame to the selected frequency interval will be
selected. This could result in an output image frame that does not exactly match the desired
frequency output. This setting can be saved to a template.

Checking the Enable Hardware Diagnostics will enable an LED light on the main controller circuit
board to flash continuously. By default, the LED is not enabled as it can cause discernable noise
on load cell signal communications within the circuit board. This checkbox should only be used
for troubleshooting purposes only. This setting will not be saved to a template and must be
checked for each test if required.
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Motion Control Settings

Motion Control Settings affect the rate and stability at which forces are achieved in force-
controlled procedures. These settings apply to preloads as well as Force Control Modes.
Changes to these settings are saved to the test template.

Motion Control Settings
X Axis Y Axis

Max. Velocity (1-10) 6 6
(Force Control)

Acceleration (1-10) 10 10

Note: To Save Velocity and Acceleration settings to a Template

Select Save As Template from the File Menu.

[J Enable Control Algorithm Settings Editing (Advanced)

Apply Done

Max. Velocity

Maximum velocity setting can be set to an integer value between 1 and 10 (see chart below for
corresponding velocity values). The velocity integer matches actuator jog speed on the BioTester
software home screen. Typically for stiffer or smaller specimens (i.e. requires a short
displacement to achieve desired force), use a lower velocity setting as this will allow for smoother
force-controlled protocols. It may take a few trials to optimize your test protocols and settings for
your experiment.

Velocity Jog Integer ‘ um/s
1 25

50
100
200
400
800

1575
3125
3250
12500

©| O N| O g | WO N

=
o
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Acceleration

Acceleration setting can be set as an integer value between 1 and 10 (see chart below for
corresponding acceleration values). Changes made to the acceleration will affect tests under both
force and displacement control. Reducing this value may help smooth force-controlled tests
under low loads or displacement-controlled tests at high speeds. Tests run with lower
accelerations will have softer transitions at direction or speed changes but may take longer than
specified to achieve specified testing cycles.

Acceleration value um/s/s

1 3200
6400
12800
25600
51200
102400
204800
409600
819200

1638400

©O©| 0| N| Oof g | W| N

=
o
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Control Algorithm Settings Editing (Advanced)

This setting offers the option to change from the programmed adaptive control algorithm to a
custom algorithm. We recommend using the adaptive algorithm that has already been optimized
for the device, as improperly tuned PID settings may result in unstable behavior. We suggest only
advanced users with specialized tests modify these PID settings. Contact CellScale for more

information regarding these settings.

For adaptive control, an initial gain value (KO) can be modified. This value must be greater than
zero, and it is set to 1 by default. The force control may undershoot or overshoot its target when
testing very soft or stiff specimens, respectively. The KO value can be reduced to adjust for
overshooting and increased to adjust for undershoot.

Motion Control Settings

X Axis ¥ Axis
Max, Velocity (1-10) -_ -_
(Force Control}
Acceleration (1-10)

Mote: To Save Velocity and Acceleration settings to a Template
Select Save As Template from the File Menu.

Edit Advanced Settings Reset to Hardware Defaults

Control Mode | Force ~ Force w
) (@) Adaptive (®) Adaptive
Algorithm
O PD O PD

o [ ]

Kp

Ki

Kd

Motes: Improperly tuned PID settings may result in unstable behavior.

Apply Done

BioTester Tip: Testing Force Control Settings

It is important to have appropriate Force Control Settings that match the material you

are testing.
a Move to Specified Load x
To safely test Force Control Settings: press ~on R e
the tool bar, or from the Tools menu select Move spectied Load () ST Y

Actuators to Specified Load. The dialogue shown on
the right will appear. The BioTester will attempt to

achieve the specified loads (forces) but will stop el ) el 7
when either the specified loads are reached, the
actuators have displaced by the maximum specified T

amount, or the timeout time has elapsed.

lﬂi ¥ Apply ’07 ¥ Apply

Maximum Displacement Maximum Displacement

Maove to Specified Load will stop when
The specified load s reached
Or the actuators have displaced (moved)
by the maximum specified amount
Or the Timeout time has elapsed
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BioTester 5000 User Manual

Range limits can be accessed by selecting Range Limits from the Settings menu.

Soft Limits

To avoid rake collisions or sample
destruction, it is useful to assign
reasonable travel limits to the actuators.
This is especially important during force
control or preloading, where if specified
loads cannot be reached, the actuators
will keep moving until they reach the soft
limits.

Min and Max Displacement, in um, set
the minimum and maximum positions to
which the rakes are allowed to move.

Max Force, in mN, sets the maximum
value of force at which a test will be
automatically stopped. The default value
is set to the capacity of the load cells.
Setting this value may be useful to
prevent sample destruction or
overloading of the load cells.

Range Limit Settings x

Soft Range Limits

Displacement Size X {um) Displacement Size ¥ (um]

100 Min 100 Min
’W Max IW Max
Force X {mM) Force ¥ (mM)
[23000 . max 23000+ Max
v Default to Load Cell I¥ Default to Load Cell

Capacity Capacity

Actuators will stop and test will terminate when soft limits are

Mote: To Save these settings to a Template
Select Save As Template from the File Menu

Configuring the Live Charting Graphs

The three graphs on the right side of the
screen provide real-time user feedback during
a test. These graphs are intended to be used
for qualitative feedback, not for detailed
analysis.

The graphs are updated at a maximum
frequency of 10Hz; certain short-duration tests
may not show all the detail that is actually
present.

The graph settings can be specified by
selecting Graphs from the Settings menu. Auto
scaling allows the axis min and max to start at
the specified values but expand if the data
values are larger or smaller than the initial
limits.

oK | Cancel
Graph Settings x

Graph 1

Mhxis

[Time (5) ~||avte =] mir[o Max | 142

fhxis

[Farce (mn | [aute =] mir[o Max [ 500

[” Clear Graph Between Sets

Graph 2

hxis

|Time (5) ~|[auta  ~| mirfo Max | 144

Yhxis

| |aute ~| mir[o

[ Clear Graph Between Sets

|Disp|acement [um} Max |4DD

Graph 3
Whxis

[Displacement jum) x| |auto =] mir[0 Max [ 400

Yhxis

|Force (mM) Max | 500

| [aute =] mir|0
[” Clear Graph Between Cycles

o]

[” Clear Graph Between Sets

Cancel |
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Graph

Force versus Time

This graph shows how the measured X and Y forces
are changing with time. Peak loads per cycle,
differences in load between the X and Y axes, and

force relaxation are all easily seen in this type of graph.

Force is proportional to nominal (engineering) stress.

| Data

Force (mh)

BioTester 5000 User Manual

Time (3)

Displacement versus Time

This graph shows how the rakes are moving with time.
The phases of the test sequence and size adjustments
due to preloading are readily apparent in this type of
graph. Displacement is proportional to nominal
(engineering) strain.

Displacement (um)

1000+
00
o0 |-

700 {--

so0 {4
s00 |-
400 1

300 1+
200 {4+
100
0

0 S 10 15 20 25 30 35 40 45 S0 S5 6O 65 VO VS 80

Time (S)

Force versus Displacement

This graph displays a qualitative representation of the
material behavior. Viscoelastic effects (like hysteresis)
and material response to different loading phases are

apparent in this graph. This graph is proportional to a

nominal (engineering) stress-strain graph.

Force (mMN)

0 100 200 300

400 500 600 700 800 900 1000
Disnlacement fum)
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7. Reviewing Test Results

The BioTester 5000 includes an additional software, Data Analysis, to review and analyze data
collected from the device. This includes graphing, curve fitting, material modeling and image
processing to determine detailed strain maps.

To open the Data Analysis program, select File>Analyze and Review Images from the Labjoy
software home page. More details about Data Analysis can be found in its user manual located in
the Documentation folder (Cellscale>Labjoy>Documentation).

S SampeTestsst - Dtadnayis - 0 %
fe Welp Toot:
smpetestist 1 v
/owe\mage,
0w [Tmee) Aus | vDisplacement (um)
Grash
e YDisplacement (um) vs. Time (S)
20 Y
Soeciren
s
200
Uatees
150
160
Toar
)
Conmerts § 120
§
Test 3 1o
Pl £
7 o0
0
a0
™
o
3 56 o 0 T TR = R EE R EE R R
Tine (5)
s [I 5
Curent Point Chart Fites Cune Fes
s Cyee Pheze Options Cunveres Eques # | Dea
la Ja o |
| oispiacement tum)
[ Force amy
[ysce o
s om Delte Seecied MGt DeeeCoert
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33



BioTester 5000 User Manual

8. System Hardware Settings

Controller

The BioTester 5000 uses an integrated control board
rather than a group of PC controlled device drivers.
This minimizes communication lag and allows the
device to operate asynchronously with the PC. The
control board details can be seen by selecting
Hardware from the Settings menu, which brings up the
window shown to the right.

Camera

The camera uses a 2/3” monochrome CMOS sensor to
obtain a resolution of 2048 pixels by 2048 pixels. The
camera shutter and gain can be controlled during the
setup phase of the test.

The camera captures images at 15 frames per second
during every test and writes these images to a buffer.
The test controller extracts images from this buffer at
the frequency specified in the Set Parameter Editor
(50Hz, 25Hz, 15Hz, 5Hz, 1Hz, 0.1Hz, 0.01Hz, or
0.001Hz). These images are written to the output
directory. The file name is the ideal capture time. The
actual capture time may differ from the ideal capture
time by as much as 1/30 of a second since the images
are extracted from a buffer.

Hardware Settings

Controller Camera Load Cells Heater External Sync Pulse

CellScale Biomat. Testing
Controller #70002
Firmware Rev 3.20
Copyright 2022

COMS Pont

Advanced

Output Communication Log

OK Cancel

Hardware Settings

Controller Camera Load Cells Heater External Sync Pulse

o Shutter (mS)

20 Gain (0-100)

Resalution

1280x960 24 bit color

Recommended Maximum Shutter = 10 m$
Auto Shutter and Gain Setings Not Recommended

OK Cancel

The test software creates an image capture log file in the output directory should this difference
be significant. This log stores the actual capture time and the idealized capture time.

The camera default shutter and gain are specific to each test template and can be set by
selecting the Camera tab in Hardware from the Settings menu. The recommended maximum
shutter speed is 10mS. Typically, the camera iris is left fully open and the shutter and gain are

adjusted to achieve the desired image brightness.
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Changing Camera Image Resolution

The default resolution of the camera is 2048x2048, the current image resolution is written at the
bottom of the screen.

Controller #70002 )
Firmware Rev 4.36

Copyright 2023

Software Version 12.41

BioTester 5000 (TMC2209)

Initializing load sensor 1
ERROR: load cell not detected.
Tension-Compress. LoadCell-P
2500mN, Ser.No. 0

Initializing load sensor 2
ERROR: load cell not detected.
Tension-Compress. LoadCell-P
2500mN, Ser.No. 0

DMKCamera startLive (56)

=1
3

Force (mN)
NoNow
i}

8

Initializing Actuators
Initializing DMK33UXCamera
System Ready!

If you would like to capture images at a higher frequency (25Hz or 50Hz) you can reduce this
resolution to 1024x1024. When you select the higher frequency, you will get the below prompt
where you can reduce the image output frequency, Reduce Camera Resolution or for 25Hz you
can leave it the same but note that images may be missed on long tests or if your computer
cannot keep up.

Warning:
! At this camera resolution (2048x2048)
and 25 Hz Image Output Frequency
your system may not be able to capture or save all images.
CellScale recommends:

Lowering Camera Reselution (Settings-> Hardware)
Or reducing image output frequency to 10Hz or lower.

Apply Anyway Reduce Camera Resolution Reduce Image Output Frequency

Selecting “Reduce Image Output Frequency” will return you to the Set Editor, selecting “Reduce
Camera Resolution” will bring you to the hardware settings window for the camera where you
can change the resolution.

To change this setting, you can access the camera settings from the Settings-> Hardware from
the top menu.

Hardware Settings X

Camera  Controller Load Cells Heater Motor Drivers Extemal Sync Pulse

Shutter (nS)
Gain (0-100)

Resolution
2048¢2048 24 bit color ~

Reducing Resolution enables higher image output frequencies.

Recommended Maximum Shutter = 10mS.
Auto Shutter and Gain Settings Not Recommended

Coce
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Load Cells

The load cells are semiconductor strain gage-based Hardware Setings

with mechanical overload protection (for the lower Conroler Camara Load Cols Hemer Exemal Syne Puisa
capacity load cells). They have an accuracy equal to .

0.2% of the rated full scale load. The load cells are ' ijfl-;.a(mm Y::.:ssﬁ.mm
available in 0.5N, 1.5N, 2.5N, 5N, 10N and 23N sizes. || | B 0000

Each load cell has a unique calibration factor which is ot Facor i) o Factor v,
stored in a chip attached to the load cell connector. 2748 23

While the load cells should not have significant Seral Number Seral Number
hysteresis or thermal drift, but temperature changes or e e
prolonged loading can introduce small offsets. It is
recommended that the zero load state be redefined
periodically. This can be done by selecting Zero Load

oK Cancel

A

Cells from the Tools menu or pressing .

The load cells are sampled at 100Hz, with hardware sample averaging to reduce noise in the
data. Further sample averaging can be implemented by selecting Advanced from the Settings
menu.

Each load cell is calibrated and has a specific calibration factor which is stored on a memory
chip in the load cell connector. The full-scale capacity, calibration factor, and serial number can
be viewed by selecting Hardware from the Settings menu. This window only displays the values
stored on the load cell’'s memory chip and cannot be modified.

In addition, it is recommended to run a calibration check on the load cells during the initial set up
of the system or when load cells are changed. See the System Calibration and Advanced
Tools section of this manual for this procedure.

Note: The Diagnotics button is only intended to be used for troubleshooting with CellScale’s
Technical Support Team. If you suspect your load cell may be damaged, contact
support@cellsacle.com.

System Alert

Though the load cells have some mechanical overload protection, they are sensitive to
excessive torque, excessive overload, transverse loading, and bending forces.
Such forces may permanently damage the load cells.

Care should be taken to apply force to the goosenecks only in the linear direction within
the rated load of the load cells being used.

DO NOT overtighten the load cell stud.
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Heater

To activate the fluid chamber heater, both power
switches on the front of the BioTester 5000 need to be —— ——
in the On position (the computer and software do not

need to be on yet). At this point, the heater will warm
the fluid to the last used temperature set point. The | = Sopoint(C)
temperature set point can be changed by selecting
Hardware from the Settings menu.

Controller Camera Load Cells Heater External Sync Pulse

| Warnings

[ show Warnings # Temperature
Not within Setpoint Tolerance

Typically, the heater will take 20 to 40 minutes to warm i Toferancs (C)
a full fluid chamber from room temperature to 37°C and
will take up to 90 minutes to stabilize at this

temperature. ' w

Control Setiings (PID)
Kp Ki Kd

Cancel

ﬂ“

When Show Temperature Warnings is enabled and the .
Current Temperature is not at the Temperature Set

Point plus or minus the specified tolerance -- a red Current Temp. 10 JES
indicator button will be displayed next to the Current

Temperature live output and a warning dialogue will

appear when you execute the test.

The Control Settings (PID) section displays the
programmed settings for the temperature control of the
heated bath. These have already been optimized for
the BioTester heated bath. This section only displays
the setting values (i.e. cannot be edited) to ensure the
correct values have been programmed.

System Alert

In the event of a dislodged or faulty temperature sensor, or if there is a lack of fluid in
the fluid chamber, the system is designed to reach a maximum temperature of 80°C.

Caution: Avoid touching the specimen stage when the heater is on, it can become
very hot!

BioTester 5000 Tip: Preheat Fluid

You can add preheated fluid to the fluid chamber to reduce warm up time.
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External Sync Pulse

A 5-volt TTL external sync pulse signal can be
generated on BioTester 5000 models containing a BNC
connector jack on the back panel.

The sync pulse will be pulsed on the very first sample
pulse, which occurs when the load cells are measured
and the motor positions of all 4 axes are read.
Thereafter a sync pulse will occur at a user definable
frequency as fast as 100 Hz (1 pulse every 10 mS) and
as slow as 0.00305 Hz (1 pulse every 327 s). The sync
pulse will stop when the sampling has been stopped.

The sync pulse is active high for 10 mS except when
operating at maximum speed (100 Hz) where the active
high pulse duration is about 550 nS.

BioTester 5000 User Manual

Hardware Settings

Controller Camera Load Cells Heater External Sync Pulse

| Generate

i Pulse Frequency Divisor
100/ 100 Hz (Min =1, Max = 32767)
Sample Values
Divisor Value ~ Frequency (Hz) Period (S)
10 10 01
100 1 1
1000 01 10

e
| ok Cancel
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9. System Calibration and Advanced Tools

Load Cell Calibration Check

If the load cells are changed, moved, or impacted, it is good practice to perform a load cell

calibration check.

The calibration check procedure is as follows:

1. Launch the calibration utility by selecting Tools, Advanced, then Load Cell Calibration

Load Cell Calibration

X Axis
1. Enter Spring Calibration Value

¥ Load Cell N)
Spring K (N/mmj |:|
Calibration Preload (mN)

2. Move Actuators to Calibration Position
a. Remove Rakes
b. Insert 5pring Calibration Brackets

¢, | Zero Load Cells
d. Attach Calibration Spring
(log Actuators if necessary)
Jog = Jog -
e, Apply Calibration Preload
Mave to Preload

3. Calibrate
Calculated Factory

BioTester 5000 User Manual

¥ Axis
1. Enter Spring Calibration Value

¥ Load Cell (M)
Spring K [N/mm] |:|
Calibration Preload (mN)

2. Move Actuators to Calibration Position
a. Remove Rakes
b. Insert Spring Calibration Brackets

«. | Zero Load Cells

d. Attach Calibration Spring
{Jog Actuators if necessary)

Jog + Jog -
e, Apply Calibration Preload
Move to Preload

3. Calibrate
Calculated Factory

Run D 58.1612

Mote: Soft Range Limits for Force are template specific
You may wish to adjust Force Soft Limits when changing load cells
Soft Range Limits can be set by selecting Range Limits from the Settings menu

2. Input the K value (spring constant) for the calibration spring provided for the installed load
cell. This value is shown on the spring case label (provided upon system delivery). If you

have multiple load cells, ensure you are using the correct spring for the capacity of the

installed load cell.

3. The load cell capacity should be automatically read and displayed, and the appropriate

calibration preload calculated.
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4. Lower the fluid chamber and install the calibration spring brackets on the goosenecks.

5. Zero the load cell using the Zero Load Cells button.

6. Using the Jog+ and Jog- buttons, drive the actuators until the posts are correctly spaced
so that the calibration spring can be installed without applying any significant load. Set
the calibration spring on the posts. The spring should be set level and in line with the
goosenecks.

7. Once the spring is installed, click the Move to Preload button. The actuators will
automatically move to the calibration preload for that load cell. For most setups, the
spring should be driven to 30% of the load cell rating i.e. for a 2.5N load cell, a preload of
750mN is specified. However, for the 0.5N load cell only, a preload of 60% of the load
cell rating is required (300mN).

8. Visually verify that the spring is loaded in a stable, horizontal, and in-line position.
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9. Click the Run button, wait for calibration to complete.

BioTester 5000 User Manual

10. Once the calibration procedure is complete, a dialog window will appear displaying the
relative % difference. This value reflected the difference between the factory calibrated
factor and the calculated factor from the calibration procedure.

b.

X Load Cell Calibration Completed

Relative Difference = -0.46%.

Calibration is within expected tolerance.

If the relative difference is greater than 4%, this could indicate damage to the

load cell. Click OK and repeat the calibration procedure. Check that the correct
calibration spring is loaded, and the correct calibration preload is applied. If you
suspect your load cell may be damaged or is reading improper values, contact
our Support team (support@cellscale.com).

Relative Difference = 17.60%.

Calibration factor is > 4% different from Previous,
Please ensure that you have used the correct spring.
Itis possible that this load cell is damaged.

For more infermation please check the User Manual
Or contact support@cellscale.com.

If you have a legacy load cell (labelled Type P in the log window), follow the
instructions in the next section.

New Log File

CellScale Biomat. Testing
Controller #70002
Firmware Rev 4.59
Copyright 2024

Software Version 12.52
BioTester 5000 (TMC2209)

nitializing load sensor 1

Tension-Compress. LoadCell-P
10000mN, Ser.No. 1884360

S

tializing load sensor 2
Tension-Compress. LoadCell-P
10000mN, Ser.No. 1932557
DMKCamera startLive (56)
Initializing DMK33UXCamera

System Ready!

11. The load cell calibration procedure must be carried out for both load cells (X and Y axis).
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Legacy Load Cell Calibration (Type P)

Load cells marked as Type P were factory calibrated with a different procedure. These types of
load cells require calibration if they are changed, moved, or impacted. The load cell information
and type is displayed in the log window in the bottom left corner of the Labjoy software.

New Log File

CellScale Biomat. Testing
Controller #70002
Firmware Rev 4.59
Copyright 2024

Software Version 12.52
BioTester 5000 (TMC2209)

nitializing load sensor 1
Tension-Compress. LoadCell-P
10000mN, Ser.No. 1884360

nitializing load sensor 2
Tension-Compress. LoadCell-P
10000mN, Ser.No. 1932557

DMKCamera startLive (56)

Initializing DMK33UXCamera

System Ready!

These load cells are calibrated with the same procedure outlined above. Complete Steps 1-9, and
follow the below steps:

1. Once the calibration procedure is completed, a dialog window will appear displaying the
relative % difference. This value reflected the difference between the previous calibrated
factor and the calculated factor from the calibration procedure.

a. |If the relative difference is less than 4%, click the Use Calculated button to apply
the calculated calibration factor. This is recommended if the load cells were
changed, moved, or impacted. Alternatively, you may choose to select the Use
Previous button to continue using the previous calibration factor.

X Load Cell Calibration Cormpleted

Relative Difference = -0.46%.

Calibration is within expected tolerance.

Use Calculated Use Previous Cancel

b. If the relative difference is greater than 4%, this could indicate damage to the
load cell. Click Use Previous or Cancel to exit the window and repeat the
calibration procedure. Check that the correct calibration spring is loaded, and the
correct calibration preload is applied. If you suspect your load cell may be
damaged or is reading improper values, contact our Support team
(support@cellscale.com).

X Load Cell Calibration Completed

Relative Difference = 17.60%.

Calibration factor is > 4% different from Previous.
Please ensure that you have used the correct spring.
It is possible that this load cell is damaged.

For more information please check the User Manual
Or contact support@cellscale.com.

2. The load cell calibration procedure must be carried out for both load cells (X and Y axis).
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Snap Image Feature
Located under >Tools>Snap Image

This feature allows the user to capture a single image during the setup phase. This can be useful
for documenting specimen loading activity and neutral (non-contact) beam position.

Snap Images X
Base Path
Browse
Name Base | Setup Current 1
oK | Cancel |

Adjusting the Camera Position and Image Magnification

The horizontal camera position can be adjusted using the knobs at the back and side of the
camera housing. If larger position adjustments are needed, the camera mast can be rotated to
allow alignment of the camera image with the testing axes.

The BioTester 5000 comes equipped with a 10X zoom lens as shown below. Other versions of
the BioTester 5000 may be equipped with a fixed magnification 75mm focal length lens (see
Appendix E: Fixed Focal Length Lens).

The image magnification can be changed by rotating the adjustable rings found on the lens. Once
the rings are adjusted to the desired settings, they can be locked using thumb screws. Adjusting
the three rings has the following effect:

1. The iris ring changes the
brightness of the image. It is
recommended to leave this
ring fully open and control —
image brightness by adjusting Iris Ring
the camera shutter and gain in
the Camera tab of the
Hardware Settings.

W-T Ring

2. The W - T ring changes the
lens zoom.

3. The F — Nring changes the
lens focus.

F-N Ring
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Using this lens, it is possible to achieve a wide ranging field of view as shown in the graph below.
Possible values for field of view are shown by the shaded gray region of this graph and can range
from 5.5mm to 24mm. To adjust the working distance (vertical position of the lens and camera
assembly), loosen the fasteners that clamp the camera housing to the mast and raise or lower the
camera then retighten the fasteners. The ideal working distance from the specimen to the lens is
15cm. It is not recommended to have the lens any closer than this.

If the camera position or magnification is changed, it may be useful to capture a single image
scale shot. A glass calibration target or a ruler is acceptable for this purpose. The scale shot will
be useful later to characterize the size of test specimens or test specimen features.

Map Field of View to Working Distance
25
20
€
E 15 e Minimum
E Magpnification
2
S 10
% e \aXimum
[ Magnification
5
0
15 20 25 30
Working Distance (cm)
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Update Firmware

Periodic firmware updates may be issued by CellScale for the BioTester. Updates are available at
https://www.cellscale.com/downloads/.

The device firmware will automatically update as part of the software installer if your device is
connected via USB and powered on.

You may update the firmware for your device at a later time if it is not available when updating
your software:

1. Connect your device via USB to your computer and power it on
2. Run the UpdateFirmware.exe located under
CellScale>LabJoy>Software>Ultilities>Update Firmware

Firmware Updater *

Checking for CelScale Device...
Device Detected on COMS. ..
Firmware Version 2,15 Detected
IUpdating Firmware to Version 2. 15...

Do not power cyde device or disconnect the USE
until this process is complete (approx. 60 Sec.)
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10. Troubleshooting

Image Appears Out of Focus
With the live image on the screen, adjust the lens focus until the image appears to be in focus.

Whenever you adjust the focus, the image magnification may change slightly. If you want to know
the absolute scale of your Images you can shap an image of a calibrated target (such as a
precision graticule or ruler) by selecting Snap Image from the Tools menu. You can estimate the
image scale by comparing the number of pixels between rake tips in the images with their known
um spacing (size) in the data output files.

ERROR - Sample Buffer Overflow Continuing Test...
Or
System Lagging, Camera Frame Lost missed capture

These errors can be caused by lack of data throughput to the location where the test data is
being saved. This has been noted by users who are saving their data to a network drive or a
USB-connected external hard drive. Another cause for these errors can be a lack of computer
resources, especially at high image capture frequencies (5 or 15Hz). It may be necessary to
upgrade the computer that is controlling the device.

Communication Errors: ReadFile failed with error 6.

When communication errors occur the live message window will display a ReadFile failed
message. Communication errors can occur if:

e The BioTester 5000 is not powered up.
e USB cables between the computer and BioTester 5000 are disconnected.
e The supply power surges or is interrupted.

When a communication error occurs, close LabJoy, check connections, power cycle the
BioTester 5000, and restart LabJoy.

BioTester 5000 Tip: Preventing Power Disruptions

We recommend plugging the BioTester 5000 (and host computer) into an
uninterruptable power supply (UPS) or battery back-up.
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11. Appendix A: Initial System Setup

The BioTester 5000 has been packed in a special container to protect it during shipping. In
addition, system accessories have been packed in several cartons contained in a separate box.
The system components listed below may be unpacked and laid out before system setup. A
space 60cm x 60cm with 100cm overhead clearance is required for setup.

Tools

Small flat head screwdriver

SAE hex wrenches:

Metric hex wrenches: 2mm, 2.5mm, 3mm
SAE Combination Wrench 5/16”

Fasteners & Parts

1
16
6

N
o

A R NN DN P PP N EPEDN

=

BioTester 5000 main unit

M4 x 10mm Socket Head Cap Screws
6-32 Hex Nuts (4 + 2 extra)
BioRakes (5 sets of 4 each)
Load Cells

Calibration Spring

Calibration Spring Brackets
Camera Lens (10X Zoom)
Specimen Mounting Bridge
Load Cell Goosenecks
No-Load Cell Goosenecks
Load Cell Brackets

Standard Specimen Cutting Jig
Razor Blades for Cutting Jig

(2 + 2 extra)

Fluid Bath

Power Cord and Supply

6’ (1.8m) USB Cable

Set of Shims (Thin and Thick)

1/16”, 3/32”, 7/64”, 9/64”, 5/32”,5/16”

I = T e S S S =Y

Press Block

Sheet of Rubber Backing Material
Actuator Caps

3"x1” Microscope Slide

Pull knob

Temperature sensor

Set extra fasteners
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Unpack System

Remove the BioTester 5000 from the shipping container

Carefully remove the protective shipping material from the container such that the BioTester 5000
can be lifted out. Remove the camera mast first then the BioTester 5000 main unit. In addition,
protective foam will have to be removed from the main unit and camera mast after lifting out the
BioTester 5000.
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Attach Camera Mast

Thread the camera post into the receiver. The knurled collar must be rotated to fasten the
camera post. It will take many turns but eventually the mast will lock into place. Try to position
the camera approximately as shown, although the final position can be adjusted later in the
procedure. Be sure to position the cables from the camera mast post towards the back where the
power entry panel is located.
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Once the camera mast is in place, the cables for the lights and camera USB will be routed out the
back of the mounting pole. The camera USB can be plugged into the PC and the connector for
the lights can be plugged into the back panel of the BioTester 5000.

)
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Place Fluid Chamber on Riser Stage

Put the fluid chamber in place on the riser stage and align the temperature probe mounting hole
with the temperature probe cable.
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Install Camera Lens

Remove the protective caps on the lens and camera body and then screw the lens onto the
camera. The correct camera setup can be fine-tuned at a later step. If using a fixed focal length

lens (typically 75mm), see Appendix E for installation.

s
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=
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mlinm
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TECHNOLOGY BASED ON STANDARDS >
Senal# 116105

C€ DMK 41AU02 FE &
[
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)<

Lens (10X Zoom) Camera (inside housing)
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12. Appendix B: Software Installation

A Windows based PC (Windows 10 or higher) with at least 2 USB ports (1x USB 3.0 minimum) is
required to operate the BioTester 5000. A label on the cover of the manual contains a web
address to download the LabJoy installation package. These files contain the software installer

for LabJoy, which is the user interface and control software for the BioTester 5000.
To install the software:

1. Go to the provided web address and download the compressed installation package.

2. Transfer this file to the computer which will be running the BioTester device.

3. After this is complete, go to the uncompressed installation folder and select LabJoy

Installer.exe. Details of typical dialogue boxes are shown below.

2% Setup - LabJoy version 12.20 =

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this agreement before
continuing with the installation.

SOFTWARE LICENSE AND WARRANTY

Read this agreement carefully. If you agree to its terms, press YES to
continue with the Setup. If vou do not agree to its terms, press NO to
abort the installation.

NOW THEREFORE THIS AGREEMENT WITNESSETH that in consideration
of the mutual covenants herein contained, and other good and valuable
consideration, the

receipt and sufficiency of which is hereby acknowledged, the parties hereby

agree as follows:

Q1 accept the agreement

()1 do not accept the agreement

s

ba b
e W
CellScale

Setup et

The installer will now try detecting your BioTester model.
Please ensure the BioTester is plugged in with the power an.
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If your BioTester is detected this screen will popup:
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2% Setup - Labloy version 12.20

BioTester 5000 Detected

X

0.
CellScale

Select different model...

Cancel

If BioTester is not detected, then you will be taken to a model selection screen where you can
select your BioTester model. To install the correct user manual and templates please select the

appropriate model.
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2% Setup - LabJoy version 12.20 = et
Model Selection e
Please select model or connect your device and press Detect Model, Detect Model Cel |S{$||(.‘
i
BioTester 3000 BioTester 5000
BioTester 6000
2% Setup - Labloy version 12.20 = *
Select Additional Tasks Toe
Which additional tasks should be performed? Cel |S($!|(.‘
Select the additional tasks you would like Setup to perform while installing Labloy, then dick Mext.
Additional shortouts:
B create Labloy desktop icon
B create BioTester user manual desktop icon
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2% Setup - Labloy version 12.20

= >
Ready to Install B_s
Setup is now ready to begin installing LabJoy on your computer, Cel |."i(?l|(.‘
Click Install to continue with the installation, or dick Back if you want to review or change any settings.
Additional tasks:
Additional shortouts:
Create LabJoy desktop icon
Create BioTester user manual desktop icon
Back Install Cancel
™ Set ersion 12.20 =
Installing 2
N 5 . ....
Pleaze wait while Setup installs LabJoy on your computer, CellScale
Extracting files...

Ci\Cellscale\Labloy\Data\SampleTest\Images \SampleTest, 0000 14,000, jpg

Cancel
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2% Setup - Labloy version 12.20

9.0,
CeIISc.aIe

biomaterials testing

LabJoy Installation Successfully
Completed

Setup has finished installing LabJoy on your computer. The application may
be launched by selecting the installed shortouts,

Click Finish to exit Setup.

B Lzunch LabJoy
B Lsunch BioTester 5000 User Manual
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13. Appendix C: Install Load Cells / Perform
Camera and Gooseneck Alignment

Connect the camera USB cable to a PC USB port. Connect the included USB cable to the main
unit and a PC USB port. Plug in the power supply to the BioTester 5000 and then proceed with
the following steps. Do not turn the BioTester 5000 on yet.

Attach the Load Cells to the Goosenecks

Ensure the correct orientation of the load cell components as shown in the below pictures.
Tighten the nuts gently to avoid damaging the load cells (just a little bit tighter than finger tight).
Keep in mind that the load cells are sensitive to excessive torque, excessive overload,
transverse loading, and bending forces.
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Attach the load cell stud to the load cell using your fingers. The load cell stud has one side with a
shoulder below the threads which should be attached to the load cell. The other end is attached
to the gooseneck. If the orientation of the stud is reversed, the load cell may not function
properly.
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Attach the other end of the load cell stud to the gooseneck. Finger tighten a 6-32 nut onto the
threaded stud. The load cell cable should be at about a 45° angle to the gooseneck as shown
below.
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The load cell and gooseneck assembly should look like this when assembled. There are two
styles of load cells available (both are shown below). For 10N and 23N load cells, ensure the
included spacer is attached before mounting it to the actuator bracket. This is important for proper
spacing between the goosenecks.

The nut may be gently tightened against the gooseneck using the included wrench, while
grasping the gooseneck only to avoid transmitting torque through the body of the load cell.
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Check that all components are snugly in place by gently turning the base of the load cell against
the gooseneck. All components should only be finger tight while being snug enough so that the
components don’t freely rotate while using the BioTester 5000.
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Attach the Load Cell Brackets to the Actuators

Before attaching the load cell/gooseneck assembly, ensure the load cell brackets are installed on
the appropriate actuators. Use M4 x 10mm (x4) fasteners provided for each bracket as shown
below. The load cell brackets are mounted on the X+ and Y+ actuators (on either side of the

camera post). The remaining brackets are mount on the other actuators. Ensure the brackets are
oriented correctly (shown below).
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Attach the Goosenecks to the Actuators

Attach each load cell/gooseneck assembly to the load cell bracket on the appropriate linear
actuator using a 6-32 nut. The load cells are attached to the actuators on either side of the
camera post. See the following images. The nut on the back of the load cell is not as sensitive as
the front side nut and may be snugly tightened using the wrench, while grasping the body of the
load cell. Make sure that the gooseneck is rotated such that it is level when the nut is fastened.
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Attach the 2 remaining goosenecks to the appropriate linear actuators using 4-40 fasteners (2
each).
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Stow Cables and Plug in the Load Cells

Before connecting the load cells, stow the cables inside the plastic cover beside the actuators,
taking care to handle the connectors by the edges. A circuit board assembly may be attached to
the connector and must be handled carefully. Also, the load cells may have a coiled length of
cable which must be carefully stowed. The initial length of cable should bend towards the outside
edge of the BioTester 5000 as shown.

Position the cables inside the cover so that they do not interfere with the actuator carriage travel,
particularly during actuator reset where the carriages are fully retracted. Plug in the load cells
and stow the connector inside the cover as well.

Also use care when unplugging the load cells. This may be done by firmly pressing on the latch
mechanism before pulling it apart. See below photos for reference.
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Attach the Temperature Probe

Attach the temperature probe and place it in the sensor pocket in the fluid chamber.

Attach the Knob to the Pull Rod

A small knob screws into the pull rod at the front of the BioTester 5000. This pull rod is used to
raise and lower the stage.

Turn on the BioTester 5000

Plug the provided power supply into the BioTester 5000 and a standard electrical outlet. The
BioTester 5000 has 2 switches. The “Main” switch turns on the BioTester 5000 main unit and
lights. The “Heater” switch turns on the heater below the stage and may be used to warm fluid
inside the fluid chamber to the temperature specified in the software. For the heater to be used,
the main switch must also be activated. However, the heater is not required to use the system.
For the set up procedure, turn on the “Main” switch only and check that the LED lights turn on.
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Launch the LabJoy Software

Launch the LabJoy software. The default screen should appear as:

BioTester 5000 User Manual

Selecting File>Collect New should bring up this window:

Create Test From Template

Select
-

Test Mame

| Test_001

Data Directory
| C\CellscalelLabjoy\Data

Template Directory

I ChCellscaletLabjoy\Templates

OK I Cancel
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The details of the software are outlined in this user’'s manual. For assembly purposes, it is only
required that we initiate the default test. Select OK.

If prompted to Reset Actuators, select “Yes”.

If prompted to Calibrate Load Cells, select “No”.

Next place a standard size BioRake (1.0mm spacing, blue caps) in each of the 4 goosenecks so
that the BioTester 5000 looks like this:
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On the LabJoy control screen, ensure that the specimen size is set to 5000um in X and Y and

then click the Move to Size button ¥
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Perform Camera Alignment

The camera position has both coarse and fine position adjustments and coarse and fine focus
adjustments. To start, loosen the fasteners which tighten to camera cover to the mast. Position
the camera cover vertically such that the working distance from the lens surface to the BioRakes
is 15cm. Next, adjust the zoom and focus rings on the lens until the BioRake tines are brought
into focus. The camera assembly can then be rotated until the camera is positioned
approximately over the center of the 4 BioRakes.

To achieve different ranges for field of view, the camera cover can be moved up and down to
change the working distance but a 15cm working distance will accommodate most applications.

Be careful to move the camera housing gently in small increments, supporting it with your hand at
all times, so as not to crash it into the goosenecks or BioRakes.
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Attempt to bring all of the BioRakes into the image, as shown below:

Next, fine tune the camera position using the knobs at the back and side of the camera housing
and fine tune the image focus using the lowest ring on the lens.
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Adjustments to the zoom can be made by adjusting the middle ring on the lens. See the section
on “Adjusting the Camera Position and Image Magnification” in section 8 of this manual for more

detail.
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Perform Vertical Gooseneck Alignment

Because the goosenecks attached to the load cells are connected by only 1 threaded stud, the
vertical and transverse alignment of the end of the gooseneck can be somewhat different each
time the goosenecks are removed and reattached. To accommodate the vertical variation, shims
between the gooseneck brackets and the actuators may need to be added or removed. Thick
and thin shims are provided (2 thins shims = 1 thick shim). At this stage, do not be concerned
with the transverse or axial positioning of the goosenecks as these will be aligned in subsequent
steps.
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By looking at the BioRakes from the side, it is possible to observe their vertical alignment. Please
add or remove shims to vertically align the BioRakes. Here are photos of poor vertical alignment
and good vertical alignment:
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Perform Transverse and Axial Gooseneck Alignment

This step requires 2 different adjustment mechanisms. The goal is to make the BioRakes look
like this:

First, make sure the BioRakes are positioned in the transverse center of the gooseneck. The
magnetic mounts that hold the BioRakes to the gooseneck fix them in the axial direction, but
allow a small amount of adjustment in the transverse direction. This is useful for alignment during
regular testing, but for the purposes of gooseneck alignment they should be in the neutral
position. The first image below shows a transversely offset BioRake and the second shows a
transversely centered BioRake.

(/11

To transversely adjust the goosenecks, loosen the fasteners that attach the goosenecks to the
actuators, slightly rotate the gooseneck, and retighten the fasteners. The on-screen image
should be helpful as a guide. The goal is to make the rake tines of opposing BioRakes collinear.
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To axially adjust the goosenecks, use the actuator jog icons in the lower left of the screen. Make
sure the “independent” radio button is selected and not the “mirror matching” button. The jog
speed should be about 7. The goal is to make a square as shown in the figure above.

Actuator Control
Jog Speed

B

J_,ﬂ +- Anes:
" Mirror Matching
" Independeni

Adjust all 4 goosenecks until you are satisfied with their transverse and axial alignment and the
rake tips form a square as shown above. It may also be necessary to make small adjustments to
the camera position. The camera alignment should be parallel to the rake alignment and the
BioRake tips should be in the middle of the image.

It is now necessary to perform a center position calibration. First, it will be necessary to
temporarily define the current position as the center position. This calibration can be performed
in the following steps:

1. Lower the fluid chamber and remove the BioRakes.

2. From the Tools menu select Advanced and then select Centre Position Calibration. This
should bring up this dialogue box:

Labloy

This Cperation will Define
! . The Current Position as the Zero Size
Forthe ¥ and ¥ axes

Do you want to Continue?

3. Press Yes.

4. Select the Reset Actuators button @ (or use Tools>Reset Actuators).

From the Tools menu select Advanced then select Move to Centre. This should bring up
this dialogue box:

Labloy

This Operation Requires
. The BioRakes to be Removed.

Do you want to Continue?

Yes | No |
6. Press Yes. Once the actuators have stopped moving, put 2 opposing BioRakes on the X

axis.

7. Using the actuator jog control arrows at the lower left of the screen, move the actuators
until all 10 BioRake tips are collinear. Make sure the “mirror matching” button is
selected for this step and not the “independent” button! Note that it is the tips of the
BioRakes that should be collinear and not the outside edge. Because the tips are
underneath the BioRakes and cannot be seen on screen, it is necessary to estimate their
position. Please use the image below as a reference:
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Example 1: BioRakes have too much overlap.

Example 2: BioRakes are correctly positioned.
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Example 3: BioRakes do not have any overlap so tips are not collinear.

Remove the BioRakes and place them on the Y axis.

9. Using the actuator control arrows, drive the Y actuators until all 10 BioRake tips are
collinear as in step 4 (IN MIRROR MATCHING MODE ONLY!).

10. From the Tools menu select Advanced and select Centre Position Calibration. This is the
final Centre Position Calibration after temporarily assigning this position in step 2. This
should bring up the following dialogue box:

Labloy

This Operation will Define
! . The Current Position as the Zero 5ize
Forthe X and ¥ axes

Do you want to Continue?

Yes | Mo |

11. Press Yes.

12. Select the reset actuators button @ (or use Tools>Reset Actuators).

To check the center position calibration, use the Tools>Advanced>Move to Centre command and
place 2 opposing BioRakes. Compare the position of the rakes to the image in step 7 above.

After a successful center position calibration, the actuators can be successfully moved to a given
sample size before beginning a test (for example, 4700um x 4700 um) and the tips should form a
square.
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Install Actuator Covers

Each actuator cover has a number written on the inside. These numbers match up with numbers
written on the inside of the main cover to ensure the best possible fit between the actuator covers
and the main cover.

The best way to install the covers is to place the back 2 pegs into the main cover and then lower
the front 2 pegs while squeezing them together. Be careful not to let the cover slip and
accidentally apply a transverse load to the gooseneck.

Perform Load Cell Calibration

The final step is to perform a load cell calibration. This procedure is detailed in Section 8 under
Load Cell Calibration.
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14. Appendix D: Mechanical Grip Usage

In addition to BioRakes, the BioTester 5000 can optionally be equipped with mechanical grips for
sample attachment.

Two types of grips are available: Screw Close (Stainless Steel) and Spring Close (Plastic).

Screw Close Grips (Stainless Steel)

The screw close grips include an 8-32 screw to close the grip faces, and a spring to keep the grip
faces open as the screw is loosened.

These grips can provide a much higher clamping force and are made of stainless steel. It is
recommended these be used with higher force load cells (e.g. 5N, 10, or 23N) to avoid
overloading or inertial force effects.

The grips and specimen can be installed with the following steps:

1. Slide each grip onto a gooseneck. For uniaxial testing, only install 2 grips along a single
axis.
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3. Jog the actuators to fit the size of the specimen.
4. Place the specimen on the grip face and tighten the fastener. Be careful to not apply
excessive downward force on the screw!
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Spring Close Grips (Plastic)

The spring close grips can be equipped with three different springs of varying stiffness to exert
different gripping forces. These springs are provided with the grips and may be switched at any
time using the provided hook tool.

The light, medium and heavy springs will exert 1.5N, 6N, and 15N of gripping force respectively.

System Alert

Select the appropriate grip spring for the load cell in use. Using a grip with the stiffest
spring in combination with a low capacity load cell (0.5-2.5N) may produce high forces
when mounting a sample. Load cells can be damaged by large off-axis or bending
forces.

The grips can be attached using the following steps:

1. Slide the grips onto the goosenecks as pictured below.
2. Tighten the locking fastener to hold the grips in place on the gooseneck. Do not over-
tighten the locking fastener as this may push the tip of the grip out of alignment.
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Sample Mounting
Squeeze the grip levers to open the jaws of the grip. Slide the end of a test specimen between
the jaws and gently release the levers. Specimens may be mounted and tested using 2 grips

(uniaxial) or 4 grips (biaxial).

System Alert

When squeezing the grip levers to open the jaws, exert force as much as possible in a
linear direction through the body of the load cell to avoid off-axis or bending forces.
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Figure 1 - Uniaxial Test Setup

Figure 2 - Biaxial Test Setup
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Changing Grip Springs

1. Using the hook tool provided, pull on the spring and remove the metal dowel holding the
grip spring in place. After this step, the spring may be slowly released.

System Alert

A fully installed spring experiences a high amount of tension. When the springs are
disengaged, be sure not to let the hook tool slip or the spring may be released at high
velocity. The use of safety glasses is recommended.
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2. Replace the old spring with a new spring inside the mounting hole.

3. Secure one side of the spring onto the grip with the metal dowel

4. Use the hook tool to pull the other side of the spring into place and secure it with another
metal dowel (Note: This step may be easier with two people).
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15. Appendix E: Fixed Focal Length Lens

In addition to the 10X zoom lens described in Section 8, the BioTester 5000 system can also use
fixed focal length lenses. Other BioTester 5000 models may have a 75mm focal length lens and a

set of lens spacers. Other focal lengths are available and are compatible with the BioTester 5000
system.

Install Camera Lens

Remove the protective caps on the lens and camera body and then screw the lens into the
appropriate series of spacer tubes. The correct camera setup can be fine-tuned at a later step.
The spacer tube is then screwed into the camera body. Spacer tubes are placed between the
lens and the camera body to change the image scale. One 40mm spacer (largest one) is a good
starting point for setting up the camera. The spacers also affect the working distance of the lens
and therefore the camera housing may need to be moved up or down on the camera mast to
accommodate changes in the number of spacer tubes.
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Adjusting Camera Position and Image Magnification

The camera position can be adjusted using the knobs at the back and side of the camera
housing. If larger position adjustments are needed, the bolts that attach the camera to the mast
can be loosened to allow rotation of the camera housing.

Using the 75mm lens and lens spacers, it is possible to achieve a field of view ranging from 9mm
to 30mm. The details of the appropriate number of spacers and the required standoff are shown
in the table below. The image magnification can be changed by adding or removing spacer tubes
located between the camera body and the lens. Increasing the total spacer tube length will result
in higher magnification while reducing the tube length will result in lower magnification. Changing
the tube length will also change the working distance of the lens. To adjust the vertical position of
the lens and camera assembly, loosen the bolts that clamp the camera housing to the mast and
raise or lower the camera housing until the image is in focus. It is helpful to make sure the lens
focus ring is in the middle of its rotation so that fine tuning the image focus can be done once the
camera housing is re-clamped.

INCREASING THE TOTAL LENGTH OF THE SPACER TUBES WILL INCREASE
MAGNIFICATION (DECREASE FIELD OF VIEW) AND DECREASE WORKING DISTANCE
(STAND-OFF).

If the camera position or magnification is changed, it is important to capture a single image scale
shot. A glass calibration target or a ruler is acceptable for this purpose. The scale shot will be
useful later to characterize the size of test specimens or test specimen features.

As the table and graph also show, it is also possible to swap in a lens with a different focal length
to achieve a different range of magnifications. This data was collected using the family of fixed
focal length lenses available from Edmund Optics (the part numbers are shown in the table). The
camera has a C-mount connection, making it possible to mount a wide variety of optical
components to best suit any application. Currently, only the standard camera is supported.
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25mm (NT56-529) | 35mm (NT56-530) | 50mm (NT56-531) | 75mm (NT56-532) | 100mm (NT56-675)
Stand Stand Stand Stand Stand
Spacer |off pix/c|FOV |off pix/c|FOV |off pix/c|FOV |off pix/c|FOV |off pix/c |[FOV
(mm) |(mm) |m (mm) [(mm) [m (mm) [(mm) [m (mm) [(mm) [m (mm) [(mm) [m (mm)
0 685| 78.6| 162.8| 1070| 71| 179.3 930( 121} 105.9
5 100| 520 24.6 215] 373| 34.3 370] 329| 38.9 820| 206| 62.2| 1540| 147| 86.8
10 53| 935| 13.7 125| 682 18.8 235| 560| 22.9 450( 404| 31.7 950( 258| 49.6
15 90| 993| 129 185| 779 16.4 350 534| 24.0 675| 366| 34.9
20 73(1273| 10.1 160| 978| 13.1 285 711] 18.0 535( 473] 27.0
25 135|1186| 10.8 245] 859| 14.9 455 578 22.1
30 125|1410 9.1 220( 959| 13.3 400| 687| 18.6
35 115|1630 7.9 20011111 115 355] 797 16.1
40 105|1842 6.9 185|1260( 10.2 320 897| 14.3
45 1002068 6.2 170(1392 9.2 2951003 12.8
600 / /
500 / /
400
E —25mm
E
%300 7 35mm [
]
c
g / o
200 —75mm [
—100mm
100
0 T T T T T T T
0 20 40 60 80 100 120 140
Field of View (mm)

NOTE: The physical camera standoff will not go below 100mm or exceed 500mm, the preceding
table and chart provides guidelines only
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16. Appendix F: Protocol for Tying and
Cutting Sutures for Biaxial Testing

In addition to BioRakes and grips, the BioTester 5000 can optionally be equipped with bracket
and pulley system to attach samples using sutures.

There are many ways to attach specimens to the suture brackets using a variety of suture
designs. This procedure outlines one way to use double-armed sutures to accomplish specimen

attachment.

1. Assemble equipment: small vice, magnifying goggles, 2 needle nose pliers, small
forceps.
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2. Bend suture hooks

BioTester 5000 User Manual

95



BioTester 5000 User Manual

3. Tie off sutures. First hook each bent hook around a secured post held in the vice. Then
tie a standard knot in the suture and use forceps to guide the location of the knot so that
it tightens at the correct location.
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4. Use pliers to tighten knot
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5. Cut off excess.
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The resulting mounted specimen should ideally look something like this:

© Copyright 2024 CellScale Biomaterials Testing.
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